Megamark Python 2.7 Setup Guide

At its core, the Choitek Megamark has an Arduino Mega 2560 microcontroller, which can be controlled by issuing serial commands via USB cable
connected to a Mac, Windows, or Linux laptop computer running Python scripts. This tutorial will show you how to set up core Python software and
the Megamark Libraries to work with the Choitek Megamark Robot Platform.
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Downloading and Installing Python 2.7

Step 1: First, install Python 2.7 from the official Python website for your chosen operation system. If you are using Windows, we recommend you
choose the x86 MSI files at the bottom. If you are using Mac, choose the Mac OS X 64-bit/32-bit installer.
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https://www.python.org/downloads/release/python-2714/

Step 2: (ONLY ON WINDOWS) Python 2.7 will install correctly through the MSI installer, but will not add the Python 2.7 directory to Windows's
system path. To add Python 2.7 to Windows's system path, go to Windows Search and open up Advanced System Settings:

System Properties P
| Computer Mame | Hardware | Advanced | System Protection | Remote |
You must be logged on as an Administrator to make most of these changes.
Performance
Wisual effects, processor scheduling, memony usage, and virtual memory
User Profiles
Desktop settings related to your logon
Startup and Recovery
System starttup, system failure, and debugging irfarmation
Environment Yariables...
[ ok || Cancel || Apply

Step 3: (ONLY ON WINDOWS) Click on the Environment Vvariables button, and new window should pop up:

Environment Variables e K_‘Jl

f User variables for DOCTOR

Variable Value
Path C:\U=ers\DOCTOR \AppData'Local\parti...
TEMP %LUSERPROFILE%:\AppDataLocal Temp
N TMP 2LUSERPROFILE % \AppDataLocal {Temp
New.. || Edit.. || Delete

System variables

Variable Value *
Path C:\Python274C:\Python27\Scripts; CiP...
PATHEXT .COM;.EXE; BAT;.CMD;.VBS; . VBE; . JS;..... K

PROCESSOR_A... AMDe4
PROCESSOR_ID... Intel64 Family 6 Model 58 Stepping 9, G... 7

New.. || Edit. |[ Deete |

’ OK l[ Cancel ]

Step 4: (ONLY ON WINDOWS) Double click on the path variable in the System Variables pane (not the user variables). At the end of the
variable value, append c:\Python27; and press OK. You can close out of Environment Variables and also Advanced System Settings now.
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Edit System Variable [ &2 |
Variable name: Fath
Variable value: B)\skype\Phone; C:\Program Filesinodejs
’ oK I [ Cancel ]
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Downloading and Installing PySerial 2.7

PySerial is a USB serial communication library for Python to allow your Mac, Windows, or Linux Laptop to communicate to attached USB Arduino

devices. There are actually 2 methods to install PySerial, detailed below:

Method 1: Install PySerial through pip and either the Command Prompt (Windows) or the Terminal (Mac and Linux). To do this on Windows, open
Windows Search and type in cmd. Inside the new window that pops up, type in pip install pyserial and press Enter.

= | B 3R

B Command Prompt - pip install pyserial
Microsoft Windows [Uersion 6.1.76811 P
Copyright (c? 2087 Microsoft Corporation. All rights reserved.

m

C:“Users“\DOCTOR>pip install pyserial

To do this on Mac, open the Terminal app (to find this app, hold Command+Space and type Terminal.). Inside the new window that pops up, type
in pip install pyserial and press Enter.
800 3} INCHULC — bash — 80x24 :

Last login: Thu Dec 21 17:58:24 on console
localhosti~ INCHULCY pip install pyserial

"
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Method 2: (WINDOWS ONLY) Install PySerial for Python 2.7 from the official Python website. If you are using Windows, download the
pyserial-2.7.win32.exe (md5) executable MS Windows Installer and run it.
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» Package Index - pyserial = 2.7

search

PACKAGE INDEX e
Browse packages
List trove classifiers
RSS (latest 40 updates)
R3S (newest 40 packages)
Terms of Service
PyPI Tutorial
PyPl Security
PyPl Support
PyPl Bug Reports
PyPI Discussicn
PyPl Developer Info

ABOUT b
NEWS =
DOCUMENTATION =

DOWRNLOAD =
COMMUNITY =
FOUNDATION b

CORE DEVELOPMENT *

PYTHON
Powered

pyserial 2.7

Python Senal Port Extension
Package Documentation
Latest Version: 3.4

Python Serial Port Extension for Win32, Linux, BSD,
Jython, IronPythaon

File Type

pyserial-2 7 tar gz (md5) Source
pyserial-2. 7. win32 exe (md5)

for Python 2 x (2.4..2.7)

pyserial-2.7.win32_py3k.exe (mdd) MS Windows installer any

for Python 3.x (3.0..3.4)

Author: Chris Liechti
Documentation: pyseral package documentation
Home Page: http://py=erial sourceforge.net/

This Wizard will inztall pyserial on your computer. Click Mext to continue ar
Cancel to exit the Setup *Wizard.

Python Serial Port Extengion for Win32, Linug, BSD, Juthan, lronPython -«

Author: Chriz Liechti

Author_email: cliechti@gms net
Description: Python Serial Port Estension
Mame: pyzenal

Ul hittp://pwserial sourceforas. net!
Wersion: 2.7

4

Built Thu Oct 17 18:12:30 2013 with distutils-2.7.2

The pyserial-2.7.win32.exe (md5) MSI installer in action.

Downloads | -

MS Windows installer | any

Not Logged In

Login
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Lost | ogin?

Login with OpenlD !
Login with Google &
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Version on
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https://pypi.python.org/pypi/pyserial/2.7

Downloading and Installing the Arduino Firmware

Once you have successfully installed the Python 2.7 programming language and the PySerial plugin for Python 2.7 in the above steps, we can now
prepare the firmware on the Choitek's Megamark's Arduino Mega 2560 board.

Step 1: If you have not done so already, follow the steps in the Megamark Arduino Setup Guide and make sure you have the Arduino software
Plug the robot's internal Arduino Mega 2560 onto your laptop via USB Serial.

and the Megamark Arduino Library installed and ready to go.
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Step 2: Fire up the newly installed Arduino IDE. Set your board type by going into Tools->Board->Arduino/Genuino Mega or Mega 2560. Set your

COM port by going into Tools->Port->COM##.

Auto Format
Archive Sketch

sketch_sepi18a i :
Fix Encoding & Reload

1 woid setup()

e 2] Serial Monitor Ctrl+Shift+M
2 ff put youl
3 Serial Plotter Ctrl+Shift+L
41}
3 WIFi101 Firmware Updater
6 ‘woid loop() 1
7| 4/ put you Board: "Arduino/Genuino Mega or Mega 2560" v
a1 Processor: "ATmega2560 (Mega 2560)" 4
Port >
Get Board Info
Programmer: "USBtinyISP" »

Burn Bootloader

1y on COM3

A

Some versions of the Choitek Megamark run on an Arduino Mega 1280 for legacy compatibility reasons. If this applies to your Megamark robot,
you will also need to change Tools->Processor->Board->ATmegal280.
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Step 3: Go over to File->Examples->Megamark->Serial. This allows the Megamark robot to communicate over USB serial to Python scripts running
on a laptop. Once the example file has been loaded, press the upload button (shaped liked an arrow in the upper left corner of the screen) to load
the code onto the Megamark Robot's Arduino Mega.

F B
@ sketch_dec?2a | Arduino 1.8.2 " ¢ = [ |u[El ﬂ
Edit Sketch Tools Help

MNew Ctrl+N
Cpen... Ctrl+ 0
Open Recent L4
Sketchbook | N
Examples ' &
Close Ctrl+ W f ko :
Save Ctrl+S L '
SaveAs..  Ctr+ShiftsS i e '
08.5trings L4
Page Setup  Ctrl+Shift+P 08.USE ’
Lot Eiish 10.StarterKit_BasicKit v I
Preferences  Ctrl+Comma 11 ArduinelSP k
Quit Ctrl+Q Examples for any board
] Adafruit Circuit Playground L4
Bridge 4
Esplora L4 U
Ethernet L4
Firmata L4
G5M L
LigquidCrystal 4
Robot Control L4
Robot Motor L4
5D L
Servo L
SpacebrewYun 1
Stepper L
Temboo L4
TFT L
WiFi 2]
| RETIRED ' Batteries
Elbows
Examples for Arduine/Genuino Mega or Mega 2560 :
1 Grippers
EEPROM '
Lasers
SoftwareSerial '
| RobotExplorerTest -
SPI ' .
| RobotMotionTest
Wire -
Serial
Examples from Custom Libraries SerialOneWay
LiquidCrystal I2C | Shoulders
Megamark Wheels
Arduin enuino Mega or e 0, ATm ega COM3
L%

Once the serial example has been loaded, the robot should now be programmable using Python 2.7.
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Running Example Python Scripts

Now that Python 2.7 has been installed with PySerial and the correct Arduino firmware has been loaded on the Megamark Robot, we can now test

some actual Python scripts for the Megamark Robot.

Step 1: Go ahead and download the Megamark Library for Python, which can be found on Github or the main Choitek website. Extract it and place
the examples in your desired location.

O Features Business Explore Marketplace Pricing This repository S Signin o Sign up
! Choitek / Choitek-Megamark @Watch | 1| HeStar | 0 ¥Fork 0
«> Code Issues 0 Pull requests 0 Projects 0 Insights
Branch: master | Choitek-Megamark / Libraries / Megamark Python 2.7 / reate new file | Find file | History
Jjohnchoi313 Added new libraries and updates! - Latest commit 770@a4d9 on Aug 24
E! 1 Shoulders.py Added new libraries and updates! 4 months ago
E) 2 Elbows.py Added new libraries and updates! 4 months ago
E) 3 Grippers.py Added new libraries and updates! 4 months ago
El 4 Wheels.py Added new libraries and updates! 4 months ago
E) 5 Robot Motion Test.py Added new libraries and updates! 4 months ago
E) & Lasers.py Added new libraries and updates! 4 months ago
&l 7 Robot Explorer Test.py Added new libraries and updates! 4 months ago
E| Megamark.py Added new libraries and updates! 4 months ago
@ 2017 GitHub, Inc.  Terms  Privacy Security Status  Help Contact GitHub APl Training Shop Blog About

Note: Every Python script that references the Choitek Megamark must have the Megamark.py file in the same folder! If you don't do this, you will be
faced with a missing library error.
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https://github.com/Choitek/Choitek-Megamark/tree/master/Libraries/Megamark Python 2.7
http://www.choitek.com/python-27.html

Step 2: Now, find the Python 2.7 IDLE application on your computer and run it.

; Python 27.13 5 BEEE

File Edit Shell Debug Options Window Help
Python 2.7.13 (v2.7.13:a06454blafal, Dec 17 2016, 20:42:59) [MSC v.1500 32 bit [;]
Intel)] on wWwin32

Type "copyright™, "credits"™ or "license ()" for more information.

oo o
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Step 3: Go to File->0pen and open elbows.py from the Megamark Python examples. Be sure to change the line referencing your COM Port.
(Normally, this would be com3 on Windows. This is something like /dev/ttyAcme on Linux, and something like /dev/cu.usbmodem1411 for Mac.)

rk Software\2 Python 2.7 (DONE)\Megamark... (-=s =) e S

i Python Shell

This example r right elbows up and down in a loop.

LR Check Module Alt+X

Run Module F5

###%# Load LibrarTeo Trr

from Megamark import Megamark #Contains all Megamark robot control definitions.
#Put Megamark.py in the same directory as this scr

#Uzed to create delays for proper timing of robot
#More info: https://docs.python.org/2/library/time

#Change 'COM3' to your COM Port. Thisz is something like "/dew/ttyACMO" on Linux
#If you don't know what your COM Port is, plug in the USE to the Arduino Mega 25
#follow these instructions: https://www.arduino.cc/en/Guide/Troubleshooting#tocl
megamark = Megamark('CCM3")

fRotate both elbows in and ocut, switching directions every two seconds
while {(True} :
# Rotate left elbow fully down.
nt {"Rotating left elbow down...™)
megamark.rotateLeftElbow (-60})
time.=zleep(2)
# Rotate left elbow fully up. |
print ("Rotating left elbow up...")
megamark.rotateleftElbow (60)
time.=leep (2}
# Rotate right elbow fully down.
print {("Rotating right elbow down...")
megamark. rotateRightElbow (-&0)
time.=zleep(2)
# Rotate right elbow fully u
print ("Rotating right elbow up...™)
megamark.rotateRightElbow (60) |
time.=leep (2}
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Step 4: Your robot will now play the Python 2.7 script continuously until the script closes. If you were running the elbows.py script, the robot should
now be happily moving its elbows in a continuous up and down motion! Be sure to try out the other examples to get a more comprehensive sense
of how to program the Megamark robot using Python 2.7.

That was pretty easy wasn't it? Now go out there and make some code of your own like the awesome robotics engineer you know you are!
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